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1. Overview 
 
Revo Uninstaller helps you uninstall software and remove unwanted programs, installed 
on your computer, even when you have problems uninstalling and cannot uninstall them 
from "Programs and Features" ("Windows Add or Remove Programs") Windows Control 
Panel applet. 
 
 Revo Uninstaller is a much faster and more powerful alternative of the "Programs 
and Features" ("Windows Add or Remove Programs") application, that allows you to 
efficiently manage your installed programs. 
 
Any program may leave a lot of data in your computer after its removal. Many programs 
leave a lot of unused data, such as Registry entries and files and folders in your computer. 
Not all leftover Registry keys in your computer are errors, so third party Registry cleaners 
cannot detect them. Leftover Registry keys, in combination with leftover files, make the 
Registry cleaner's job ineffective. Revo Uninstaller helps you remove the Registry keys, files 
and folders, left by the program you uninstall. 
 
 With its advanced and fast algorithms, Revo Uninstaller analyzes the application's 
data before uninstall and scans your computer for leftovers after the built-in uninstaller of 
the program you are uninstalling finishes. After the program's regular uninstaller runs, you 
can remove additional unnecessary files, folders and Registry keys, usually left over on 
your computer.  
 

Even if you have a broken (corrupt) installation of an application, Revo Uninstaller 
can scan your hard disk drives and Windows Registry and show all files, folders and 
Registry keys found, so you can delete them easily. 
 

With its unique Hunter mode, Revo Uninstaller offers you some simple, easy to use, 
but effective and powerful software removal features. You can use it to manage your 
installed and/or running programs directly from your desktop, using their icons or opened 
windows. 
 
Revo Uninstaller gives you another 8 handy and powerful tools to clean up your system. 
Here is the list of the tools and utilities included in Revo Uninstaller: 
 
Auto Start Manager - Stop programs and services that start automatically on Windows 
startup; speed up loading of Windows; 
 
Windows Tools Manager - Handy and useful tools bundled with every version of 
Windows; easily find useful system tools and options; 
 
Junk Files Cleaner - Find and remove unnecessary files from your computer; free up disk 
space and delete files you do not need; 



Revo Uninstaller - User's Guide 

5 | P a g e  

 

 
Browsers History Cleaner - Erase web browser history, visited pages history and 
temporary internet files of Internet Explorer, Firefox and Opera web browsers; free up a lot 
of disk space by deleting temporary internet files like temporary saved videos, temporary 
flash files, temporary pictures etc.; 
 
Office History Cleaner - Remove the history of most recently used files in MS Office; 
remove your tracks by deleting the list of last opened MS Office documents; 
 
Windows History Cleaner - Remove the history of recently opened files, delete temporary 
files, remove usage tracks and other history items that are saved by Windows; remove your 
tracks saved by Windows for a lot of operations; 
 
Unrecoverable Delete Tool - Erase files and folders forever; be sure that nobody could 
recover your files and folders after deleting; 
 
Evidence Remover - Make sure already deleted files, folders and other data are 
unrecoverable; securely erase your data. 
 

2. User Interface 
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The main window of Revo Uninstaller is divided into few movable and flexible user 
interface components.  
 
The Main toolbar contains some of the main features of Revo Uninstaller. By default it is 
located on the top of the main window. It contains some of the main features of Revo 
Uninstaller and the available commands for the currently active tool. Through the Tools 
button you can show the Tools toolbar with all existing additional tools. Both toolbars can 
be turned on and off from a context menu, and can be moved by dragging too (pressing the 
left mouse button over a part of the toolbar different than a button).  You can show or hide 
the text of the icons from the options. The size of the icons can be changed from the options 
too. 
 

At the bottom of the main window is the Status Bar. Depending on the active tool it 
can show some additional information. 

The Description Panel is by default located above the status bar. It shows some 
common information about the active tool. It can be turned on and off from the context 
menu and it can be moved by dragging (pressing the mouse button anywhere in its 
window).  The Description Panel supports also an “auto hide” feature that hides and shows 
the panel on mouse over. To activate/deactivate the “auto hide” option press the small 
button with the shape of a pin in the right upper part of the panel window. 
 

Currently active tool is shown in the middle part of the main window. There could be 
only one active and visible tool at a given moment. 

 
 

3. Uninstaller 
 

When Revo Uninstaller is started, its main window shows installed programs on your 
computer. Depending on the settings, other items, such as system updates or system 
components may be listed also. Depending on the view setting, programs are shown as Icons, 
List, and with Details such as Name, Size, Version, Type, Installation Date, Company, 
Comment, and Website. 

From the uninstaller toolbar using the View drop-down button you can change the 
way that the list of applications may be viewed. Click on the little arrow on its right side. This 
will show you the menu with all view options - Icon, List and Details. 

By default, installed programs are shown in Details view, where data is divided in 
columns. You can right-mouse click on the column header and show, hide and adjust some 
of the columns. 

In Icons view and when you select a program, in the Description Panel, some of the 
properties of the program, like: Icon, Size, Version, Install Data, Company, Update Link and 
Web Site, are shown below. Similar data you may also see when you hover the mouse cursor 
over a program in the list. In that case the data is shown as Tooltip, next to the mouse cursor. 
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Using the Search field in the upper part of the main window, you can filter the list of 
the programs by name or company publisher. When you type some text in the Search field, 
right below you will see the number of found programs that match the search criteria. 

 
Some commands available from the context menu are:  
 Uninstall – start the uninstall process of selected program 

Search at Google for – Use it to search with Google for the application name, or the 
producer of the application. This command will open your default web browser and display 
the results of the search. 

Open About Link – This command will open your default web browser and load the 
address containing information about the application. 

Open Help Link – This command will open your default web browser and load the 
address containing help information. 

Open Update Link – This command will open your default web browser and load the 
address providing update information. 

Install Location – Opens Windows Explorer, so you can see where the selected 
application is installed. 

Open Registry Key – Opens the registry editor (RegEdit.exe) and displays the 
registry key containing the uninstall information of the selected application. 

Export list to – export installed programs to HTML, TXT. You can choose which 
details you can export. 
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The main command you can use on the list of installed programs is Uninstall.  
If during the uninstall the build-in uninstaller of the programs runs "Change" or 

"Repair" command and tries to reinstall or repair the program instead of uninstalling it then 
you can use the command Forced MSI Uninstall. This command is visible in the context 
menu only for the MSI(Microsoft Installer) programs, which default uninstall command is 
not Uninstall. So if you experience such problem, just cancel the build-in uninstaller of the 
program and the uninstall wizard of Revo Uninstaller and start it again using this command 
from the context menu  

 
 In some cases, when a program from the list is selected, depending on the installer of 
that program, you may see on the Commands toolbar the command Change or Repair. That 
command is only shown when the installer of the program supports such functionality. 
Executing it will open a window, letting you change the modules of the installed program or 
repair its installation in case it does not work properly. 

Refresh command refill the list of installed programs reading again the data from the 
Registry 

Selecting a program and pressing Uninstall toolbar button will show up the Uninstall 
Wizard. Alternatively you can double left mouse click over the selected program or right-
click on the selected item and then click the Uninstall command on the displayed menu. 

After the Uninstall Wizard is shown Revo Uninstaller is going to create a system 
restore point (if it is not disabled in Options) and then it is going to run the built-in 
uninstaller of the uninstalled program. Revo Uninstaller is not directly involved in that part 
of the uninstall process. If errors occur during this initial uninstall process, contact the 
author or provider of the application! Or you can ignore the error message and continue the 
uninstall. After you have finished uninstallation with the built-in uninstaller, you have to 
press Scan button to continue the uninstall process with Revo Uninstaller.  
 
NOTE: The built-in uninstaller may show up behind other open windows and you may need 
to switch between them by using the Alt+Tab key combination – hold Alt key and press Tab. 
 
You can choose the scanning mode before the scan: 

Safe - performs a scan in the Registry and the hard drive to find leftover items that 
are safe to delete. This is the fastest mode; 

Moderate - includes the Safe mode and performs an extended scan to find all of the 
application's leftover information in the most common places of the Registry and the hard 
drive;  

Advanced - includes the Moderate mode and performs a deep and thorough scan to 
find all of the application's leftover information in the Registry and on the hard drive. This is 
the slowest mode. 
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Pressing Scan button will trigger scanning for leftovers and the results (if any) will show up 
automatically. Revo Uninstaller shows found leftover Registry items first. Registry keys and 
values found as created by the uninstalled program are in bold. Not bold keys are considered 
as not created by the uninstalled program. You can also check mark them but they will not 
be deleted! They have check mark options just because it is easier to select the top parent 
and automatically check mark its sub items – no need to go through all of them and check 
mark them separately, so, whatever you check mark, when you press Delete button only 
check marked bold items are going to be deleted, even when Select All button is used. 
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Revo Uninstaller contains advanced algorithms to find leftovers related only to the 
uninstalled program. In some cases these algorithms, especially in Advanced uninstall mode, 
could list some items related to another program. It could happen, but NOT necessarily (not 
always), when you have installed two or more versions of a program, for example "Adobe 
Photoshop CS" and "Adobe Photoshop CS5". In this case the user can distinguish the 
leftovers. It also could happen if you want to uninstall only a component of a big software 
package (i.e. a component of Microsoft Office). In that case Revo Uninstaller could list the 
rest of the components as leftovers, because they are installed in the same folder and Revo 
Uninstaller cannot distinguish them (Excel, PowerPoint, Word etc). It is better to use Revo 
Uninstaller to remove the whole software package instead of a component.   
 Revo Uninstaller also includes safety algorithms and will NOT list some leftovers if it 
decides that deleting them can harm your system. Therefore, although it does a better job 
than Windows Programs and Features application and the built-in uninstaller of the 
application you want to uninstall, it still may miss something due to safety and the uninstall 
mode you choose - Safe, Moderate and Advanced. 
 In Revo Uninstaller we have implemented a lot of protections to make it safer and 
secure, while trying to maximize its accuracy in searching for leftovers. 
 Basically you can easily distinguish the leftovers (by name, by install path) and in 
most of the cases Select All button could be safely used. There are GUIDs and CLSIDs 
(alphanumeric items) which are correct leftovers in 99% of the cases, so you can safely 
delete them. 
 Note that Revo Uninstaller creates a Windows System Restore Point and by default 
delete every deleted files or folder to the Recycle Bin. 

There is also a context menu, which you can see by right-mouse clicking on the 
leftover items: 
 Expand All – expands all items of the shown Registry tree – by default it is expanded 
so you may not see any difference first time you use this command; 
 Collapse All – collapses all items of the shown Registry tree; 
 Export All – export shown leftover data to HTML file; 
 Expand selected key – expands only the selected key and its sub items; 
 Collapse selected key – collapses the selected key and its sub items; 
 Uninstall selected key – deletes the key from the system; 
 Mark selected key as Created – marks selected key as created by the program you 
are uninstalling. This feature is useful when you see a Registry key which you are sure is 
created by the program, but not marked as created because of the safety algorithms in Revo 
Uninstaller; 
 
Warning: Be very careful using this command. Mark the key only if you are sure that 
it belongs to the uninstalled program! 
 
 Add to Exclude List – adds the selected key to the exclude list, which protects the key 
from deletion. Excluded keys have red color and you can edit the exclude list from options in 
Revo Uninstaller; 
 Open Registry Key… - open the selected Registry key in Windows Registry Editor 
(RegEdit.exe). 
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 After finishing removal of the Registry leftovers you can press Next button and 
continue with the file and folder leftovers. Note that Next button may not be available if there 
are no other leftovers found. 
 
 

 
 
Revo Uninstaller shows you found leftover files and folders so you can check the results and 
delete them. You can see the number of leftover files and folders found.  
 Deleted files and folders are moved to the Recycle Bin by default, so you can recover 
them from there. You can change that option from Options -> Uninstaller.  
 
There is a context menu, which you can use by right mouse-click on a file of folder: 
 Open – command on the context menu which acts the same way if you double click 
on a file or folder in Windows Explorer. Note that if there is no file association for the file you 
click on nothing will happen; 
 Properties – command on the context menu, which acts the same way if you right-
mouse click on a file and choose Properties – shows properties like file size, attributes, date 
of creation, modification etc; 
 Open Containing Folder – opens the folder that contains selected item in Windows 
Explorer; 
 Export – exports the list of found leftover files and folders to a HTML file. 
 
 You can use Select All button to select all found leftover files and folders at once and 
then use Delete button to delete them. 
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4. Windows Apps 
 
The Windows Apps module lists all installed Windows apps, this includes built-in 

apps when you install Windows, and apps downloaded from Microsoft Store. The module 
helps you uninstall any app with a single click. To start the Windows Apps module press its 
button in the main toolbar 

 
NOTE: Windows Apps module is available on Windows 8 and newer version of 

Windows. 
 
The main window has a few columns with Name, Size, Install Date, Version, 

Publisher, and Description. Right clicking the header of a column allows you to change the 
alignment and choose which columns are shown. The entire list may be sorted by clicking a 
column header. 

 

 
 
 
 The main command is Uninstall - selecting an app and pressing the Uninstall button 
from the main toolbar will bring up the Uninstall Wizard. Revo Uninstaller tries to create a 
full Registry backup (if this is not disabled in the Options) and a System Restore Point, and 
then runs the default command to uninstall the app. After the app is uninstalled, you have to 
click the Scan button to continue the uninstallation process with Revo Uninstaller. 
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Revo Uninstaller shows found leftover Registry entries first. Registry keys and values 
found as created by the uninstalled program are in bold. Entries that are NOT in bold are 
considered as not created by the uninstalled program. You can safely check them (leave them 
checked), as they will not be deleted! Entries not in bold are displayed for two reasons: 1) 
for information: to give you a better idea of the tree structure, and 2) to make selecting 
leftovers for deletion easier and faster. You can simply check an entire parent branch, as that 
will automatically select all of its children. This eliminates the need to check each individual 
leftover item manually and separately. So, again, whatever items you check, when you press 
the Delete button, only entries that are checked and in bold will actually be deleted. This 
applies to when the Select All button is used as well. 
 

You can bring up a context menu by right clicking. These are the available commands: 
 Expand All – expands all items in the Registry tree – by default it is expanded so you 
should not see any difference the first time you use this command. 
 Collapse All – collapses all items in the Registry tree. 
 Export All – export shown leftover data to an HTML file. 
 Expand selected key – expands the selected key and its sub items. 
 Collapse selected key – collapses the selected key and its sub items. 
 Uninstall selected key – deletes the selected key from the system. 
 Mark selected key as Created – marks the selected key as created by the program 
you are uninstalling. This feature is useful when you see a Registry key, which you are sure 
is created by the program but is not marked as created because of the safety algorithms in 
Revo Uninstaller. 
 
Warning: Be very careful using this command. Mark the key only if you are absolutely 
certain that it belongs to the uninstalled program! 
 

Add to Exclude List – adds the selected key to the exclude list, which protects the key 
from deletion, and marks it in red. You can edit the exclude list from the Options in Revo 
Uninstaller. 
 Open Registry Key… - opens the selected Registry key in the Windows Registry 
Editor (regedit.exe). 
 
 After removing the Registry leftovers, you can click the Next button, and continue to 
the file and folder leftovers. Note that the Next button may not be available if there are no 
other leftovers found. 

Revo Uninstaller shows you found leftover files and folders so you can check the 
results, and delete the ones you want. Revo Uninstaller also displays the number of files and 
folders found, as well as their total size on the drive. 
 Deleted files and folders are moved to the Recycle Bin by default, so you can recover 
them from there. You can change that option in Options -> Uninstaller. 
You can bring up a context menu by right clicking on a file or folder: 
 Open – acts the same way as if you double clicked on the file or folder in Windows 
Explorer. Note that if there is no program associated with the file, nothing will happen. 
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 Properties – acts the same way as if you right clicked on a file, and chose Properties 
– shows various properties like file size, attributes, date of creation, modification, etc. 
 Open Containing Folder – opens the folder that contains the selected item in 
Windows Explorer. 
 Export – exports the list of found leftover files and folders to an HTML file. 
 
 You can use the Select All button to select all found leftover files and folders at once, 
and then use the Delete button to delete them. 
 
To refresh the list of listed Apps you can use the command Refresh from the main toolbar. 
  

Other commands available in the context menu for Windows Apps are:  
Run – tries to start the app 
Search at Google for – use it to search online using Google for the application’s name 

or publisher. This will open your default web browser and display the results of the search. 
Install Location – opens the location where the app is currently installed in Windows 

Explorer. 
Open in Microsoft Store – opens the app’s page in the Microsoft Store 
Open Registry Key – opens the Registry editor (regedit.exe) and displays the 

Registry key containing the uninstallation information for the selected application. 
 

5. Hunter Mode   

 
Hunter mode is an innovative and flexible feature of Revo Uninstaller, which 
gives you the ability to uninstall, stop or delete only by aiming applications icon 
on the desktop, quick launch toolbar, system tray or opened application with just 

one click. This can be very useful because a lot of applications are loading on start up and 
stay in the system tray without your agreement or you don’t even know which application is 
that. 
 
When you press the Hunter mode button on the main toolbar of Revo Uninstaller, the 
current window will disappear and a small blue target window will appear at the right upper 
corner of your screen. Hunter mode is now activated. 
 
There are some main options in Hunter mode, available on its context menu (right-mouse 
click): 

Open main window – opens Revo Uninstaller’s main window and exits Hunter mode; 
Auto Start with Windows – sets Hunter Mode to start automatically on Windows 

startup; 
Always on top – if turned on, Hunter Mode’s window stays on the top of all other 
opened windows. If turned off, the quickest way to view the Hunter Mode is to left 

click the 
Revo Uninstaller Pro’s icon in the system tray. 
Window's size – there are three available sizes of the current window – Small, Middle 

and Large; 
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Transparency - sets the Hunter Mode window’s transparency – 50% by default; 
Help – opens help file; 
EXIT – exits Revo Uninstaller. 

 
To operate in Hunter mode you have to do the following steps: 
 
1. Press the left mouse button over the blue target window and hold it pressed; 
2. Move the mouse over an item supported by Hunter mode (desktop shortcut, open window, 
icon etc.). While doing so a tool tip is shown with information about the application you will 
select if you release the button; 
3. Release the left mouse button and a menu will show up; 
4. Select desired command from that menu: 
 

Uninstall – start the Uninstall module of Revo Uninstaller; 
Stop Auto Starting – disable the application from auto start when Windows starts; 
Kill – Stop the application; 
Kill and Delete – stop and delete the application;  
Open Containing Folder - Open a new instance of windows explorer and explore the 
directory, where the application is located; 
Search at Google for - Use it to search with Google for the application name, file name 

or the company name - producer of selected application. This command will open your 
default web browser and load the result of current search in the Google web site; 

Properties - Show application's executable file's properties; 
Cancel – Cancel the operation. 

 

6. Tools 
 

Revo Uninstaller gives you 8 handy and powerful tools to clean up your system. To access 
the Tools you have to press the Tools button on the main toolbar. Then on the left side of 
the main window appears the Tools toolbar containing buttons of all the available tools: 
AutoRun Manager, Junk Files Cleaner, Windows Tools, Browsers Cleaner, MS Office 
Cleaner, Windows Cleaner, Evidence Remover, and Unrecoverable Delete 
  

6.1. AutoRun Manager 
 
 Auto Run Manager allows you to manage auto running programs and services on 
Windows startup. With this tool you can not only enable or disable applications from auto 
starting on Windows startup but you can also get more information about a particular 
application set to run when Windows starts. You can get information about the publisher of 
the auto starting program or service, its description, its launch path - where it is saved on 
your computer or the status of the application - if it's running or not. If this information is 
not enough to decide whether to enable or disable the program from auto starting, you can 
get more information about the publisher and the executable file name directly from Google 
with just one right-mouse click. 



Revo Uninstaller - User's Guide 

16 | P a g e  

 

 When you buy a brand new computer it has no or few applications which are loaded 
at Windows startup. During the time you install new applications to your PC some of these 
applications are installed as auto starting on Windows startup. You can see some of them in 
the "system tray" (near the clock) as small icons. Often such applications are messengers, 
adware, advertisement programs and applications you do not need to start automatically. 
 When an application is started it takes resources such as RAM, CPU time. The amount 
of these resources depends on started applications but, no matter how much memory and 
resources it takes, when the number of started applications is bigger the slower is your 
computer. 
 If you want a program to start automatically when Windows starts, a common place 
to put the program is in the Startup folder of the Start Menu.  
 Some applications like anti-virus, firewalls and system programs must be started on 
Windows startup to keep your system running smoothly and without problems. Get as much 
information for an auto running program as possible and decide whether to enable or disable 
it. 
 
 The most common task you would like to do is to disable/enable an application from 
auto starting when the Windows operation system is started. This can be done with a single 
click; all you have to do is to uncheck/check the check box in front of the application name. 
 

 
 
 You can right-mouse click on the column header and show or hide some of the 
columns. This way you can also choose what to print.  
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There are several commands you can use in AutoRun Manager: 
 Run - You can run an application, which status is NOT RUNNING just by selecting the 
application in the list of applications and press Run button on the toolbar; 
 
 Kill - You can stop an application, which status is RUNNING just by selecting the 
application in the list of applications and pressing the Kill button on the toolbar; 
 
 Remove - If you want to remove an application from the list and prevent its auto 
loading when Windows is starting, you have to select the application and press Remove 
button from the toolbar. Note, that it is better to uncheck mark it only, because, in that way, 
it will be removed from startup but will remain in the list of AutoRun Manager, so you can 
check mark it again if you need it in future;  
  
Set auto start for: 
 All users – if you want that program to start on every user login; 
 Current user – if you want that program to start when only current user is logged 
Select to auto-start from: 
 Registry: Run – on every startup of Windows – this option will add startup setting 
to Windows Registry, which is common place for auto startups; 
 Registry: RunOnce – only once on the next startup of Windows – this option is 
similar to previous one but will start the program only once and then that Registry key will 
be deleted automatically by Windows; 
 Startup Folder – on every startup of Windows – this option will add a shortcut to 
the program in Startup folder, which is also a common place for startups and is accessible 
from Start menu -> All Programs. 
 
There are more commands you can execute over a selected application:  
 Run Process - run selected application; 
 Kill Process - stop selected application; 
 Search at Google for - use it to search with Google for the selected start up name, file 
name, publisher name or description. This command will open your default web browser 
and load the result of current search in the Google web site; 
 Open containing folder - opens a new instance of windows explorer and explores 
the directory, where the selected application is located; 
 Go to Location - runs "Registry Editor" and opens the Registry key with auto starting 
information of the selected application; 
 Open Registry Key - opens "Registry Editor" and the Registry key with the uninstall 
information of the selected application; 
 Remove selected - remove selected application from the list; 
 Remove all not valid - remove all applications with status NOT VALID from the list; 
 Remove all not running - remove all applications with status NOT RUNNING from 
the list; 
 Remove all disabled - remove all disabled applications from the list; 
 Properties - show application's properties; 
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 Open Windows Services - Opens the Windows Services management application 
and lets you get more properties and options to manage the services. 
 

6.2. Junk Files Cleaner 
 

Junk Files Cleaner allows you to find and remove various types of junk and 
unnecessary files from your computer. Many of the Windows applications create junk files. 
Normally, such files are deleted by the application that had created them as soon as it did not 
need them. However they may remain permanently on your hard drive if there is an 
unexpected termination of the parent application, a system crash, etc. If this happens, it will 
cause reduction of free disk space (even hundreds of megabytes), or may slow down system 
speed and performance. 
 

With Junk Files Cleaner you can select which of your drives to scan and what 
extension of files to scan for. The most common temporary and junk files extensions are 
built-in, but you can also add whatever extension you want.  
 

 
 
Commands of Junk Files Cleaner: 

Scan - to start scanning for junk files, just press the Scan button from the current 
toolbar or from Command menu. This action will perform a scan operation with your current 
options. A small window appears to wait until the scan is complete. There is a "Cancel" button 
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on that window, if you press it the scan process will be interrupted and you will only see the 
junk files found until that moment; 

Delete - after the scan process is completed, all found files are loaded in the list with 
their full path, their name and their size. To delete any file of the shown press Delete button 
and all check files will be deleted; 
There are more commands you can execute over selected file(s): 

Open – open selected file; 
Search at Google for – Use it to search with Google for the name of the selected file. 

This command will open your default web browser and load the result of the current search 
in the Google web site; 

 Open containing folder - Open a new instance of windows explorer and explore the 
directory, where the selected file is located; 

Properties – Show file’s properties; 
Check all items – Set a check in front of all items in the list; 
Uncheck all items –Remove the check in front of all items in the list; 
Check all selected items - Set a check in front of all selected items in the list; 
Uncheck all selected items - Remove the check in front of all selected items in the 

list. 
You can adjust settings on Junk Files Cleaner by pressing Options button in the toolbar or 
from the Tools menu. 
 

6.3. Windows Tools 
 
There are a lot of handy and useful tools and components bundled with every Windows 
operating system. Some of them have complex command line options, others are difficult to 
access. Windows tools give you a fast - one click - access to more than ten tools of Windows, 
which you use in your daily work. Almost all of them are included in Windows XP, Windows 
Vista and Windows 7. 
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6.3.1. System Restore 
 
 System Restore is a component of the Windows operating system you can use to 
restore your computer to a previous state, if a problem occurs, without losing your personal 
data files (such as Microsoft Word documents, browsing history, drawings, favorites, or e-
mail). System Restore monitors changes to the system and some application files, and it 

 Windows 

 

Windows Tools                                                                         

XP Vista 7 8 (Pro) 8.1 10 Server 

2012 R2 

№ x86 x64 x86 x64 x86 x64 x86 x64 x86 x64 x86 x64 x64 

1 System Restore √ √ √ √ √ √ √ √ √ √ √ √  

2 Network Diagnostics √             

3 Network Information √ √ √ √ √ √ √ √ √ √ √ √ √ 

4 Security Center √ √ √ √ √ √ √ √ √ √ √ √  

5 System Properties √ √ √ √ √ √ √ √ √ √ √ √ √ 

6 System Information √ √ √ √ √ √ √ √ √ √ √ √ √ 

7 TCP/IP Netstat Command √ √ √ √ √ √ √ √ √ √ √ √ √ 

8 On-Screen Keyboard √ √ √ √ √ √ √ √ √ √ √ √ √ 

9 Disk Defragmenter √ √ √ √ √ √ √ √ √ √ √ √ √ 

10 Services √ √ √ √ √ √ √ √ √ √ √ √ √ 

11 Shared Folders √ √ √ √ √ √ √ √ √ √ √ √ √ 

12 Group Policy √ √ √ √ √ √ √ √  √ √ 

(Pro) 

√ √ √ 

13 Add/Remove Windows Components √ √ √ √ √ √ √ √ √ √ √ √  

14 Microsoft Windows Malicious Software 
Removal Tool 

√  √ √ √ √  √  √ √ √ √ 

15 Windows Backup and Restore √ √ √ √ √ √ √ √ √ √ √ √  

16 Task Scheduler √ √ √ √ √ √ √ √ √ √ √ √ √ 

17 Check Disk √ √ √ √ √ √ √ √ √ √ √ √ √ 

18 System File Checker √ √ √ √ √ √ √ √ √ √ √ √ √ 
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automatically creates easily identified restore points. These restore points allow you to 
revert the system back to a previous time. They are created daily and at the time of significant 
system events (such as when an application or driver is installed). You can also create and 
name your own restore points at any time. 
 

6.3.2. Network Diagnostics 
 
 Network Diagnostics is a component of the Windows operating system you can use 
to gather and display information about your computer hardware and operating system, 
your internet configuration, and your modem and network adapter configuration. With the 
Network Diagnostics tool, you can perform a scan of your system and test network 
connectivity and whether or not your network-related programs and services are functional. 
It gathers a variety of basic information about the computer system, which can be helpful 
when given to a support person trying to help you troubleshoot your system. This tool is 
available only on Windows XP.  
 

6.3.3. Network Information 
 
 Network Information uses a component of the Windows operating system you can 
use to display all current TCP/IP network configuration values and refresh Dynamic Host 
Configuration Protocol (DHCP) and Domain Name System (DNS) settings, Displays the full 
TCP/IP configuration for all adapters including IP address, MAC address, subnet mask, 
default gateway, Windows Internet Naming Service (WINS) and DNS configuration. Adapters 
can represent physical interfaces, such as installed network adapters, or logical interfaces, 
such as dial-up connections. 
 

6.3.4. Security Center 
 
 Security Center is a component of the Windows operating system you can use to check 
the status of your computer for the three security essentials - Firewall, Virus protection 
software and Automatic Update. If a problem is detected with any of the three essentials (for 
example, if your antivirus program is out of date), the Security Center sends you an alert and 
provides recommendations on how to better protect your computer. 
 

6.3.5. System Properties 
 
System Properties is a component of the Windows operating system you can use to do the 
following: 
 
    * View basic information such as your CPU type and RAM memory. 
    * View and change settings that control how your computer uses memory and finds certain 
information. 
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    * Find information about hardware and device properties, as well as configure hardware 
profiles. 
    * View information about your network connection and logon profile. 
    * Report system and program errors to Microsoft or your system administrator when they 
occur. 
 

6.3.6. System Information 
 
 System Information is a component of Windows operating system that collects and 
displays system configuration information for local and remote computers. This includes 
information about hardware configurations, computer components, and software, including 
signed drivers and unsigned drivers. System Information is a support tool that you can use 
to quickly locate information about your computer and its operating system 
 

6.3.7. TCP/IP Netstat Command 
 
 TCP/IP Netstat Command is a component of the Windows operating system that 
displays all active TCP connections and the TCP and UDP ports on which the computer is 
listening and displays the executable involved in creating each connection or listening port. 
In this case the executable name is in [ ] at the bottom, on top is the component it called, and 
so forth until TCP/IP was reached. With simple words this command shows which 
applications are connected and on which port to the Internet and which are listening for 
incoming connections. 
 

6.3.8. On-Screen Keyboard 
 
 On-Screen Keyboard is a component of the Windows operating system that displays 
a virtual keyboard on the screen, allowing users with mobility impairments to type data 
using a pointing device or joystick. On-Screen Keyboard is intended to provide a minimum 
level of functionality for users with mobility impairments. You can also use On-Screen 
Keyboard if you think that there is a Key-Logger installed on your PC and all the keys you 
type are being recorded. On-Screen Keyboard eliminates the possibility of recording typed 
keys. 
 

6.3.9. Disk Defragmenter 
 
 Disk Defragmenter is a component of the Windows operating system that analyzes 
local volumes and consolidates fragmented files and folders so that each occupies a single, 
contiguous space on the volume. As a result, your system can access files and folders and 
save new ones more efficiently. By consolidating your files and folders, Disk Defragmenter 
also consolidates a volume's free space, making it less likely that new files will be 
fragmented. The process of consolidating fragmented files and folders is called 
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defragmentation. After defragmentation your hard disk drive will be well-arranged and your 
system will work faster and with ease. 
 

6.3.10. Services 
 
 A service is a type of applications that run in the background. Service applications 
typically provide features such as client/server applications, Web servers, database servers, 
and other server-based applications to users, both locally and across the network. Services 
is a component of Windows operating system you can use to: 
 
    * Start, stop, pause, resume, or disable a service on remote and local computers. You must 
have the appropriate permission to start, stop, pause, restart, and disable services. 
    * Manage services on local and remote computers. 
    * Set up recovery actions to take place if a service fails, for example, restarting the service 
automatically or restarting the computer. 
    * Enable or disable services for a particular hardware profile. 
    * View the status and description of each service. 
 

6.3.11. Shared Folders 
 
 Shared Folders is a component of the Windows operating system you can use to 
manage shared resources over a network, control user access permissions, session activity, 
shared resource properties and to view a summary of connections and resources, uses for 
local and remote computers. With Shared Folders, you can: 
 
    * Create, view, and set permissions for shared resources. 
    * View a list of all users connected over a network to the computer, and disconnect one or 
all of them. 
    * View a list of files that have been opened by remote users, and close one or all of the open 
files. 
 

6.3.12. Group Policy 
 
 Group Policy is a component of the Windows operating system that includes policy 
settings for User Configuration, which affect users, and for Computer Configuration, which 
affect computers. Group Policy settings define the various components of the user's desktop 
environment that a system administrator needs to manage, for example, the programs that 
are available to users, the programs that appear on the user's desktop, and options for the 
Start menu. To create a specific desktop configuration for a particular group of users, use the 
Group Policy snap-in. 
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6.3.13. Add/Remove Windows Components 
 
 Add/Remove Windows Components helps you manage installed Windows 
components on your computer. After Windows OS is installed on your computer, you can use 
the Add/Remove Windows Components to add a Windows component that was not included 
in the original installation, or to remove an existing Windows component that you no longer 
require. 
 

6.3.14. Microsoft Windows Malicious 
Software Removal Tool 

 
 The Microsoft Windows Malicious Software Removal Tool checks computers running 
a Windows operating system for infections by specific, prevalent malicious software, and 
helps remove any infections found. This malicious software includes viruses, worms and 
Trojan horses. When the detection and removal process is complete, the tool displays a 
report describing the outcome, including, if any malicious software was detected and 
removed. 
 

6.3.15. Windows Backup and Restore 
 
 Windows Backup and Restore allows you to make copies of data files for all people 
who use the computer and provides you with the ability to create a system image. You can 
let Windows choose what to back up or you can select the individual folders, libraries, and 
drives you want to back up. A system image includes Windows and your system settings, 
programs, and files. You can use a system image to restore the contents of your computer if 
your hard drive or computer ever stops working. 
 

6.3.16. Task Scheduler 
 
 Task Scheduler helps you schedule automated tasks that perform actions at a specific 
time, or when a certain event occurs. It provides the ability to schedule the launch of 
programs or scripts at pre-defined times, or after specified time intervals. Task Scheduler 
maintains a library of all scheduled tasks, providing an organized view of the tasks and a 
convenient way to manage them. 
 

6.3.17. Check Disk 
 
 Check Disk opens a command prompt window to execute the chkdsk.exe Windows 
command. Check Disk verifies the logical integrity of the file system on the Windows volume. 
Check Disk checks for problems related to bad sectors, lost clusters, cross-linked files, and 
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directory errors. These types of problems can be caused by system crashes or freezes, power 
glitches, incorrectly turning off a computer, etc.  
 

6.3.18. System File Checker 
 
 System File Checker allows you to scan for and restore corruptions in Windows 
system files, verifying their versions. If it finds a problem, it will attempt to replace the 
problematic files from the Windows DLL Cache. If the file is not in the Windows DLL Cache 
or the DLL Cache is corrupted, you will be prompted to insert the Windows installation disk. 
 

6.4. Browsers Cleaner 
 
 Your browser makes a detailed record of every web site you've ever visited. It's easily 
accessible from your browser window and simply by pressing a button anyone can see 
where you've been browsing on the web. Revo Uninstaller erases web site history of web 
browsers including Internet Explorer, Firefox, Google Chrome and Opera. With Browsers 
Cleaner you can also delete temporary internet files, which are all the pictures you've seen, 
all the online videos you've watched and all the web pages you've visited. Deleting 
Temporary Internet Files will free a lot of space on your hard disk. 
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 Depending on the history setting you want to cleanup and the browser you have, you 
have to check mark these options and press the Clear toolbar button or the Clear command 
on the Commands menu. For faster check\uncheck of items you can use the right-click menu 
command and check\uncheck all items of specific browser or all items in the list. 
 

6.5. Microsoft Office Cleaner 
 

 
 

 MS Office Cleaner allows you to remove history of most recently used files in MS 
Word, Excel, Access, PowerPoint and Front Page. If you do not want somebody else to see 
your last opened or edited spreadsheets, documents or other files created using MS Office, 
just select those you do not want others to see and click the Clear button. Your most recently 
used files will no longer be listed. Windows also keeps a record of your recent files. Use MS 
Windows Cleaner included in Revo Uninstaller to clear them too. 
 
MS Office Cleaner includes the following options to clarify most recently used files of: 
 
     Microsoft Excel 2000, XP, 2003, 2007, 2010, 2013 and 2016 
     Microsoft Word 2000, XP, 2003, 2007, 2010, 2013 and 2016 
     Microsoft PowerPoint 2000, XP, 2003, 2007, 2010, 2013 and 2016 
     Microsoft FrontPage 2000, XP, 2003  
     Microsoft Access 2000, XP, 2003, 2007, 2010, 2013 and 2016 
 
 Depending on the program, which history settings you want to cleanup, you have to 
check mark it and press the Clear toolbar button or the Clear command on the Commands 
menu. For faster check\uncheck of items you can use the right-click menu command and 
check\uncheck all items of in the list. 
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6.6. Windows Cleaner 
 

 
 
 Microsoft Windows keeps tracks of many things you do with your computer, like file 
search history when you search for file and folders; recently opened document history; 
open/save history used in standard open/save dialogs from different applications installed 
on your computer; start menu clicks history; last opened Registry key history and more. 
Windows Cleaner allows you to remove all this history and temporary files. It's a useful tool, 
because you can remove all this history from one place quickly and easily. You can also empty 
your Recycle Bin and delete temporary files, freeing more disk space. 
 
Available options of Windows Cleaner are: 
 
      Clear Recent Documents History; 
      Clear Start Menu Run History; 
      Clear Find File History; 
      Clear Printers, Computers and People Find History; 
      Empty Clipboard; 
      Clear “MS Paint” Recent Files History; 
      Clear “MS WordPad” Recent Files History; 
      Clear “Regedit” Last Opened Key History; 
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      Clear Common Dialog Open Save Recent History; 
      Clear Common Dialog Last Visited Folder History; 
      Empty Recycle Bin; 
      Delete Windows Temporary Files; 
      Delete Start Menu Click Logs; 
      Delete crash memory dump files; 
      Delete Chkdsk (Check Disk) recovered file fragments; 
 Delete Thumbnail Cache. 
 
Depending on the history item you want to clean up, you have to check mark that option and 
press the Clear button on the toolbar or the Clear command on the Commands menu. 
For faster check\uncheck of items you can use the right-click menu command and 
check\uncheck all items of in the list. 
 

6.7. Evidence Remover 
 

 
 
 Deleting your files and folders does not mean that they are gone forever. When you 
empty Windows Recycle Bin your files and folders are just marked as deleted but they are 
not physically erased. There is a chance to recover deleted data from 10 years or older PC 
and this data may be very important and confidential. You can easily get back your important 
documents and other files that you have deleted using any recovery tool or un-delete 
program. This is where the Evidence Remover tool of Revo Uninstaller comes. Evidence 
Remover will eliminate all chances to get data back from your hard drive. It will forever erase 
files and folders already deleted, but left physically on your hard disk. No matter what tool 
you or somebody else will use to recover the data, including professional and expensive 
recovery and un-delete tools, the result will always be the same - the data erased with 
Evidence Remover is impossible to recover. 
 To erase already deleted files and folders you have to check mark the drive where 
these files are deleted from. Then you have to press the Execute toolbar button or the Execute 
command from the Commands menu.  
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The process is slow, because the data is overwritten 3 times randomly. The speed depends 
on: 

- Computer Processor (CPU); 
- The size of the selected drive; 
- Running programs; 
- Running security software – anti-virus, Internet Security, etc. 

 
 During the process, the free disk space decreases, because Evidence Remover creates 
a very huge file and writes random data in it. That huge file is deleted at the end of the process 
– the free disk space is restored. 
 

6.8. Unrecoverable Delete 
 

 
 
 If you want to securely delete a file or folder and to be sure that no one, with any tool, 
could be able to recover this file or folder, then use Unrecoverable Delete. Deleting files and 
emptying Windows Recycle Bin does not mean these files are gone forever. They are still on 
your Hard Disk Drive or other storage, but marked as deleted. Anyone, with a tool available 
free or commercial, could recover deleted data very easily. Revo Uninstaller’s Unrecoverable 
Delete tool makes this impossible, even if you try to do that with the most advanced and 
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expensive tool on the market. Deleting files in Windows means that they are marked as 
deleted and the space they allocated is free to use. This is because, if Windows has to 
physically erase all deleted files, it will take time and will slow down your computer. Beside 
this, there is a lot of system, temporary and other files not so important to be unrecoverable. 
Unrecoverable Delete physically erases all the files and folders and that's why it takes more 
time than simple deleting. 
 
Unrecoverable Delete has the following commands: 

- Add File(s) – using this command you can add files for unrecoverable delete from 
different folders and disk drives;  

- Add Folder – using this command you can add a folder for unrecoverable delete. 
All sub folders and files will be deleted permanently; 

- Delete Forever – executes permanent erasing of the added files and folders. You 
can cancel the process, but files, erased before the cancel will be unrecoverable, 
so please carefully select the files and folder you want to delete. 

 
 The window of the Unrecoverable delete tool supports drag and drop of files and 
folders. Because Revo Uninstaller has administrative rights, programs with lower rights 
cannot drop files and folders in it. For example, if you run Windows explorer or any other 
file manager with standard user account (not as administrator), you will not be able to drag 
and drop files in Unrecoverable delete tool. 
 

7. Options 
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7.1. General 
 
Here you can find some general options of Revo Uninstaller like: 
 Current Language: - drop down box, which you can use to change the localization of 
Revo Uninstaller. Note, that it is set when you install Revo Uninstaller to the language you 
choose on install; 
 Check for update on startup – Revo Uninstaller will check if there is a new version 
available by connecting to www.revouninstaller.com on startup, but only once a day. No 
personal information is sent or received. Note, that you have to allow Revo Uninstaller to 
connect to the Internet in your firewall settings; 

Skip information messages shown by Revo Uninstaller – if you do not want to see 
information messages from Revo Uninstaller enable this option. Information messages are 
messages like “Revo Uninstaller finished scanning for leftovers”;  
 Skip warning messages shown by Revo Uninstaller – if you do not want to see 
warning messages from Revo Uninstaller, enable this option. Warning messages are 
messages like “Are you sure you want to remove selected item?”; 
 

7.2. Uninstaller 
7.2.1. General 

 
Here are the main options affecting the whole uninstaller: 

Show system updates (not supported in Windows Vista and Windows 7,8,10) – 
the option shows Windows updates on Windows XP; 

Show system components – some programs have additional components which are 
removable but marked as a component of another program and by default Revo Uninstaller 
does not list this kind of programs; 

Use program's uninstall data to get the Install Date property - if this option is 
turned on Revo Uninstaller gets the installation dates of the installed programs from their 
own Uninstall data written by their built-in uninstalled in the Registry. Otherwise it uses 
other Registry data to get the installation dates 
 Enable fast loading mode - if the mode is enabled Revo Uninstaller starts much 
faster skipping the loading of the icons and calculation of the size for the programs that 
haven't provided such one. 
 Only run the built-in uninstaller - when you select the Uninstall command Revo 
Uninstaller will start only the built-in uninstaller of the selected program; 
 Make a System Restore Point before uninstall – If Windows System Restore is 
enabled Revo Uninstaller requests from it creation of a system restore point; 

Open the Uninstall wizard maximized - this option causes the window of the 
Uninstall Wizard to be shown always maximized for better review of the leftovers; 

Check mark all leftovers by default - leftovers as Registry items, files and folders, 
found by Revo Uninstaller, will be check marked automatically.  

NOTE: When Delete button is clicked ONLY check marked bold items will be deleted, 
even if all items are check marked! 

http://www.revouninstaller.com/
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Forcibly stop running executable files during their uninstall – if this is turned on, 
and Revo Uninstaller is trying to uninstall an executable file(s), then Revo Uninstaller will 
try to stop that file(s) forcibly. This will prevent some running files from remaining on the 
system until the next restart or even after that; 
 Delete leftover files and folders to the Recycle Bin - if the option is check marked 
Revo Uninstaller deletes found as leftover files and folders to the Recycle Bin. 
 

7.2.2. Exclude 
  

There are two types of items you can exclude during uninstall – Registry items and 
folders. 
When a program is uninstalled, Revo Uninstaller shows the leftover Registry items and some 
of the items we know for sure that are not created by the uninstalled program, so, we have 
an exclude list for these items. You are also able to add or remove such items (using Add and 
Remove buttons) or Reset Defaults – remove all added and restore all removed items. 
 
A Registry key could be excluded only by adding the full path to the key for example: 

HKEY_LOCAL_MACHINE\SOFTWARE\Classes 
 
There is an option for each Registry key called Include Sub keys, which can be check 
marked. That option will exclude all sub keys of that Registry key – not only the key itself.  
 
In front of each Registry key there is a check box, which is used to enable or disable 
(depending on whether it is check marked or not) the exclusion of a Registry key. If there is 
a check mark the key is considered as excluded. 
 
Exclude list supports wild cards as (?) and (*), which means you can exclude several keys at 
once or without knowing the exact name of that particular Registry key. For example: 

 HKEY_LOCAL_MACHINE\SOFT????\Classes 
This will exclude all Registry keys in HKEY_LOCAL_MACHINE beginning with SOFT and 
having 4 characters following SOFT word, because the (?) sign means any character. 
   

HKEY_LOCAL_MACHINE\SOFT*\Classes 
This will exclude all Registry keys in HKEY_LOCAL_MACHINE beginning with SOFT word and 
no matter how they end – any length, any characters after the SOFT word. You can use (*) 
char to replace the whole key name as: 

HKEY_LOCAL_MACHINE\*\Classes 
But this also will exclude the whole branch like: 

HKEY_LOCAL_MACHINE\SOFTWARE\Classes 
HKEY_LOCAL_MACHINE\HARDWARE\Classes 
HKEY_LOCAL_MACHINE\Microsoft\Classes 
HKEY_LOCAL_MACHINE\Your Company\Classes 
HKEY_LOCAL_MACHINE\Anything goes here\Classes 
 

You can also use a combination of (?) and (*).  
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If it is necessary by some reason when a program is uninstalled you can exclude 

certain folders from the list of found leftovers. You can add folders to the list using Add 
button and browse to the folders you want to exclude. You can also Remove added folder or 
just uncheck mark it, which will remove it from consideration as excluded.  
 

7.3. Junk Files Cleaner 
 
You can add processes to be included in the monitoring using Add button and specify full 
path to the process. You can also Remove added processes or just uncheck mark them, which 
will remove them from consideration as included. Reset Defaults button will remove all 
added processes and add default ones. 
 

7.3.1. General  
 
Delete files to the Recycle Bin - if this option is check marked all junk files are moved 

to the Recycle Bin. This can be considered as additional safety but will not increase the free 
disk space until you empty your Recycle Bin. 

 
Ignore files accessed last 24 hours - this option is enabled by default, because some 

junk and temporary files are in use during the scan for junk files and it is better to leave them. 
 

There is a list of patterns (mostly file types), and their description, where you can select 
which pattern to scan for when scan operation is performing. Files matching with a given 
pattern will be shown in the result list only if there is a check mark before the pattern. If you 
remove a check mark, the pattern after it will not be taking into consideration while scanning 
is being done. 

 
 You can also add or remove patterns from the list by using the buttons underneath. 
To add new pattern press button Add and a small window will appear, where you can type 
the desired pattern using wild cards (?,*) and press OK to add it to the list or Cancel to ignore 
operation. 
 
 To remove a pattern, select it in the list and press the Remove button. If you want to 
restore the default built-in patterns, just press Set Default button and all of your patterns 
will be deleted and returned to the default. 

 

7.3.2. Exclude  
 

If you wish to exclude any files contained within any directory from a scan, there is a 
list with patterns of paths on the local drives, where you can select which pattern to be 
scanned while the scan operation is performing. Directories matching with a given pattern 
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will be skipped in the scan process only if there is a check mark before the pattern. If you 
remove a check mark, the pattern after it will be scanned for unnecessary files. 
 
You can also add or remove patterns from the list by using the buttons underneath. To add a 
new pattern press the Add button and a small window will appear, where you can type 
desired pattern using wild cards (?,*)  and press OK to add it to the list or Cancel to ignore 
operation. 
 
To remove a pattern, select it in the list and press the Remove button. If you want to restore 
the default built-in patterns, just press the Set Default button and all your patterns will be 
deleted and returned to the default 

 
 

7.4. View 
 

Some visual aspects of Revo Uninstaller can be changed and adjusted here.  
You can adjust whether the toolbars should have text labels and if the icons of the toolbars 
should be small or large. Turn on the Show small icons in Details view option if you want 
to view small icons in Details view of the Uninstaller and AutoRun Manager. 
Reset main window panels settings command resets position and size of the panels of 
main window of Revo Uninstaller - toolbars, status bar, description panel 
Reset Details view control settings command resets the customization (all column 
changes) of the details view control on the tools that have such view type like the Uninstaller 
and AutoRun Manager. 

 
 


